Creating Mobile Apps with Xamarin.Forms
Cross-platform C# programming for iOS, Android, and Windows Phone

Charles Petzold
Contents

Foreword ................................................................................................................................................................. xv

Introduction .................................................................................................................................................................. xvi

Chapter 1 How does Xamarin.Forms fit in? ............................................................................................................. 1

Cross-platform mobile development ....................................................................................................................... 2

The mobile landscape .................................................................................................................................................. 2

Problem 1: Different userinterface paradigms ........................................................................................................ 2

Problem 2: Different development environments .................................................................................................. 3

Problem 3: Different programming interfaces ...................................................................................................... 3

Problem 4: Different programming languages ...................................................................................................... 3

The C# and .NET solution .......................................................................................................................................... 4

A single language for all platforms .......................................................................................................................... 5

Sharing code ............................................................................................................................................................... 6

Introducing Xamarin.Forms ........................................................................................................................................ 8

The Xamarin.Forms option .......................................................................................................................................... 8

XAML support ............................................................................................................................................................. 13

Platform specificity ...................................................................................................................................................... 14

A cross-platform panacea? ......................................................................................................................................... 15

Your development environment ................................................................................................................................ 15

Machines and IDEs .................................................................................................................................................... 16

Devices and emulators .............................................................................................................................................. 16

Installation .................................................................................................................................................................. 17

Creating an iOS app .................................................................................................................................................. 17

Creating an Android app .......................................................................................................................................... 18

Creating a Windows app .......................................................................................................................................... 18

All ready? .................................................................................................................................................................. 19
Chapter 6  Button clicks ........................................................................................................ 113
  Processing the click ........................................................................................................ 113
  Sharing button clicks ...................................................................................................... 116
  Anonymous event handlers ............................................................................................ 119
  Distinguishing views with IDs ........................................................................................ 121
  Saving transient data ...................................................................................................... 124

Chapter 7  XAML vs. code ................................................................................................ 131
  Properties and attributes .............................................................................................. 132
  Property-element syntax ............................................................................................... 136
  Adding a XAML page to your project ........................................................................... 140
  The XAML compiler ...................................................................................................... 145
  Platform specificity in the XAML file ............................................................................ 146
  The content property attribute .................................................................................... 150
  Formatted text ................................................................................................................ 152

Chapter 8  Code and XAML in harmony ..................................................................... 156
  Passing arguments .......................................................................................................... 156
    Constructors with arguments ....................................................................................... 156
    Can I call methods from XAML? ................................................................................ 159
  The x:Name attribute ...................................................................................................... 161
  Custom XAML-based views ........................................................................................... 167
  Events and handlers ....................................................................................................... 172
  Tap gestures .................................................................................................................... 175

Chapter 9  Platform-specific API calls ....................................................................... 182
  Preprocessing in the Shared Asset Project ................................................................... 182
  Parallel classes and the Shared Asset Project .............................................................. 185
Chapter 10  XAML markup extensions ................................................................. 198
  The code infrastructure .................................................................................. 198
  Accessing static members ............................................................................. 200
  Resource dictionaries ..................................................................................... 206
    StaticResource for most purposes ............................................................... 207
    A tree of dictionaries ................................................................................ 214
    DynamicResource for special purposes ..................................................... 218
  Lesser-used markup extensions .................................................................. 221
  A custom markup extension ...................................................................... 222

Chapter 11  The bindable infrastructure .......................................................... 227
  The Xamarin.Forms class hierarchy .............................................................. 228
  A peek into BindableObject and BindableProperty ..................................... 235
  Defining bindable properties .................................................................... 241
    The read-only bindable property .......................................................... 246

Chapter 12  Styles ................................................................................................. 252
  The basic Style ............................................................................................ 252
  Styles in code ............................................................................................. 259
  Style inheritance ......................................................................................... 261
  Implicit styles ............................................................................................ 265
  Dynamic styles .......................................................................................... 270
  Device styles ............................................................................................. 278

Chapter 13  Bitmaps ............................................................................................. 283
  Platform-independent bitmaps .................................................................... 284
    Fit and fill ............................................................................................... 287
    Embedded resources ............................................................................... 289
    More on sizing ....................................................................................... 295
  Browsing and and waiting ....................................................................... 307
  Streaming bitmaps .................................................................................... 311
Chapter 14  Absolute layout........................................................................................................338
  AbsoluteLayout in code........................................................................................................339
  Attached bindable properties ..............................................................................................344
  Proportional sizing and positioning ....................................................................................348
  Working with proportional coordinates ............................................................................350
  AbsoluteLayout and XAML ..................................................................................................355
  Overlays ...............................................................................................................................359
  Some fun .............................................................................................................................362

Chapter 15  The interactive interface.......................................................................................371
  View overview ....................................................................................................................371
  Slider and Stepper ...............................................................................................................372
    Slider basics ......................................................................................................................372
    Common pitfalls ...............................................................................................................375
    Slider color selection ......................................................................................................377
    The Stepper difference ....................................................................................................382
  Switch and CheckBox ........................................................................................................384
    Switch basics ..................................................................................................................384
    A traditional CheckBox ...................................................................................................387
Chapter 19  Collection views ........................................................................................................535

Program options with Picker ........................................................................................................536
The Picker and event handling .......................................................................................................536
Data binding the Picker ..................................................................................................................540
Rendering data with ListView ......................................................................................................543
Collections and selections ............................................................................................................544
The row separator ..........................................................................................................................545
Data binding the selected item ......................................................................................................547
The ObservableCollection difference .........................................................................................551
Templates and cells .......................................................................................................................553
Custom cells .................................................................................................................................561
Grouping the ListView items .........................................................................................................565
Custom group headers ..................................................................................................................569
ListView and interactivity .............................................................................................................570
ListView and MVVM .....................................................................................................................574
A collection of ViewModels ..........................................................................................................574
Selection and the binding context .................................................................................................586
Context menus ..............................................................................................................................590
Varying the visuals .........................................................................................................................595
Refreshing the content ..................................................................................................................597
The TableView and its intents ........................................................................................................604
Properties and hierarchies ............................................................................................................604
Chapter 20  Async and file I/O................................................................................. 624
From callbacks to await....................................................................................... 625
  An alert with callbacks ................................................................................. 626
  An alert with lambdas ................................................................................... 630
  An alert with await .......................................................................................... 630
  An alert with nothing .................................................................................... 632
Saving program settings asynchronously.......................................................... 635
A platform-independent timer............................................................................ 639
File input/output................................................................................................ 641
  Good news and bad news ............................................................................. 641
  A first shot at cross-platform file I/O ............................................................ 643
  Accommodating Windows Runtime file I/O .................................................. 650
Platform-specific libraries.................................................................................. 651
  Keeping it in the background ...................................................................... 662
  Don’t block the UI thread! ............................................................................ 664
Your own awaitable methods.......................................................................... 664
  The basic Mandelbrot set ............................................................................ 666
  Marking progress ........................................................................................... 673
Cancelling the job............................................................................................... 676
An MVVM Mandelbrot ...................................................................................... 680
Back to the web................................................................................................ 701
Chapter 21  Transforms ..................................................................................... 704
The translation transform................................................................................... 705
Text effects......................................................................................................... 708
Jumps and animations ....................................................................................... 711
The scale transform........................................................................................... 715
Chapter 22  Animation ................................................................. 748

Exploring basic animations .......................................................... 748

  Setting the animation duration .................................................. 750
  Relative animations .................................................................... 751
  Awaiting animations .................................................................... 751
  Composite animations .................................................................. 754
  Task.WhenAll and Task.WhenAny .................................................. 756
  Rotation and anchors ................................................................. 756
  Easing functions .......................................................................... 759
  Your own easing functions ......................................................... 763
  Entrance animations ..................................................................... 773
  Forever animations ....................................................................... 778
  Animating the Bounds property ................................................... 793
  Your own awaitable animations ................................................... 805

Deeper into animation ...................................................................... 808

  Sorting out the classes ............................................................... 808
  ViewExtensions class ................................................................... 809
  The Animation class ..................................................................... 810
  AnimationExtensions class .......................................................... 811
  Working with the Animation class ................................................. 812
  Child animations .......................................................................... 815
  Beyond the high-level animation methods ..................................... 818
  More of your own awaitable methods .......................................... 819
  Implementing a Bezier animation .................................................. 823
Chapter 23  Triggers and behaviors ................................................................. 835

- Triggers ........................................................................................................ 836
  - The simplest trigger ................................................................................. 836
  - Trigger actions and animations ............................................................... 841
  - More event triggers ................................................................................. 847
  - Data triggers ............................................................................................ 853
  - Combining conditions in the MultiTrigger ........................................... 858

- Behaviors ................................................................................................... 868
  - Behaviors with properties ...................................................................... 871
  - Toggles and check boxes ...................................................................... 876
  - Responding to taps ............................................................................... 889
  - Radio buttons .......................................................................................... 893
  - Fades and orientation ............................................................................ 908

Chapter 24  Page navigation ........................................................................ 920

- Modal pages and modeless pages ........................................................... 921
  - Animated page transitions .................................................................... 930
  - Visual and functional variations ............................................................ 931
  - Exploring the mechanics ....................................................................... 937
  - Enforcing modality ............................................................................... 947

- Navigation variations ................................................................................ 955
  - Making a navigation menu .................................................................... 957
  - Manipulating the navigation stack ......................................................... 963
  - Dynamic page generation ...................................................................... 965

- Patterns of data transfer .......................................................................... 969
  - Constructor arguments .......................................................................... 970
  - Properties and method calls .................................................................. 974
  - The messaging center ............................................................................ 981
  - Events ...................................................................................................... 984
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The App class intermediary</td>
<td>987</td>
</tr>
<tr>
<td>Switching to a ViewModel</td>
<td>990</td>
</tr>
<tr>
<td>Saving and restoring page state</td>
<td>995</td>
</tr>
<tr>
<td>Saving and restoring the navigation stack</td>
<td>999</td>
</tr>
<tr>
<td>Something like a real-life app</td>
<td>1006</td>
</tr>
<tr>
<td><strong>Chapter 25  Page varieties</strong></td>
<td>1020</td>
</tr>
<tr>
<td>Master and Detail</td>
<td>1020</td>
</tr>
<tr>
<td>Exploring the behaviors</td>
<td>1021</td>
</tr>
<tr>
<td>Back to school</td>
<td>1029</td>
</tr>
<tr>
<td>Your own user interface</td>
<td>1034</td>
</tr>
<tr>
<td>TabbedPage</td>
<td>1042</td>
</tr>
<tr>
<td>Discrete tab pages</td>
<td>1043</td>
</tr>
<tr>
<td>Using an ItemTemplate</td>
<td>1050</td>
</tr>
<tr>
<td><strong>Chapter 26  Custom layouts</strong></td>
<td>1054</td>
</tr>
<tr>
<td>An overview of layout</td>
<td>1054</td>
</tr>
<tr>
<td>Parents and children</td>
<td>1055</td>
</tr>
<tr>
<td>Sizing and positioning</td>
<td>1056</td>
</tr>
<tr>
<td>Constraints and size requests</td>
<td>1060</td>
</tr>
<tr>
<td>Infinite constraints</td>
<td>1064</td>
</tr>
<tr>
<td>Peeking inside the process</td>
<td>1066</td>
</tr>
<tr>
<td>Deriving from Layout&lt;View&gt;</td>
<td>1074</td>
</tr>
<tr>
<td>An easy example</td>
<td>1075</td>
</tr>
<tr>
<td>Vertical and horizontal positioning simplified</td>
<td>1082</td>
</tr>
<tr>
<td>Invalidation</td>
<td>1084</td>
</tr>
<tr>
<td>Some rules for coding layouts</td>
<td>1087</td>
</tr>
<tr>
<td>A layout with properties</td>
<td>1088</td>
</tr>
<tr>
<td>No unconstrained dimensions allowed!</td>
<td>1099</td>
</tr>
<tr>
<td>Overlapping children</td>
<td>1106</td>
</tr>
<tr>
<td>More attached bindable properties</td>
<td>1117</td>
</tr>
<tr>
<td>Layout and LayoutTo</td>
<td>1122</td>
</tr>
</tbody>
</table>
Chapter 27  Custom renderers

The complete class hierarchy .................................................. 1127
Hello, custom renderers! .......................................................... 1130
Renderers and properties ....................................................... 1135
Renderers and events ............................................................... 1149
The idea for producing a book on Xamarin.Forms is one we’ve had for almost as long as we’ve been working on the product. Of course, we didn’t know it would be written by such a talented and highly regarded author. We couldn’t have asked for a better-qualified person, nor someone who would require so little of us to get inside our minds! Charles offers insights in such beautiful and simple ways, as you’ll soon discover.

This book distills more than three years of effort to create a modern, cross-platform toolkit as an easy to understand, organized progression of ideas. The examples contained within this book are simple enough to be understood without the need for a fancy IDE or compiler, yet they retain the complexity required to be applicable to problems faced by real applications. Better, the following chapters don’t focus on a single platform but take a holistic approach to understanding mobile development for all platforms, not just iOS or Android or Windows.

We wanted to avoid the pitfalls commonly associated with cross-platform toolkits: either they have an alien-feeling user experience, or they are limited to the lowest common denominator across all the target platforms. The pattern we fell in love with was to use native APIs, as is the traditional Xamarin way. Xamarin.Forms offers the user the smallest usable subset of APIs that are required to write the majority of an app in a unified codebase, and then gives access to the underlying toolkit for fit and finish. The end result is that the user has the ability to express the majority of their app in unified code, without losing the flexibility of per-platform implementation.

It works, too, by removing the need to provide every feature inside the abstraction. Instead, we allow simple access down to the toolkit so that application developers are able to bring out those platform-specific features that make their app shine. Ninety percent of what makes your app work is the same as for every other app out there, but working across platforms shouldn’t force you to give up the 10 percent that makes your app unique.

Because of this, Xamarin.Forms is in many ways the “untoolkit,” a toolkit that isn’t so much a toolkit as it is a way to look at mobile development and use it as a pattern to create mobile apps. If the authors of Xamarin.Forms can offer you anything to retain as you read this book, it is that toolkits, platforms, and technologies change very rapidly, but patterns, especially good patterns, rarely die.

When I read the preview editions of this book, I was blown away. Charles understood what we were trying to do better than anyone else ever had. This book is written knowing that Xamarin.Forms is about the pattern of creating mobile apps. I believe that by the time you finish reading, you too will understand what it is we set out to create.

Xamarin.Forms cocreator,
Jason Smith
Introduction

This is the third version of a book about writing applications with Xamarin.Forms, the exciting mobile development platform for iOS, Android, and Windows unveiled by Xamarin in May 2014. (The first two versions of this book were Preview Editions.) Xamarin.Forms lets you write shared user-interface code in C# and XAML (the Extensible Application Markup Language) that maps to native controls on these platforms.

The Windows support of Xamarin.Forms includes the Windows Runtime (WinRT) for targeting Windows 8.1 and Windows Phone 8.1 devices, and the Universal Windows Platform (UWP), which is a form of the Windows Runtime that targets Windows 10 and Windows 10 Mobile devices with a single program.

The two previous versions of this book were called Preview Editions because they were not complete. At 1200 pages, this is the first edition that can claim to be complete, even though several topics are not included and Xamarin.Forms continues to be progressively enhanced with no sign of slowing down.

All information about this book can be found on the book’s home page at:


Who should read this book

This book is for C# programmers who want to write applications using a single code base that targets the three most popular mobile platforms: iOS, Android, and Windows, encompassing the Universal Windows Platform and Windows Phone.

Xamarin.Forms also has applicability for those programmers who eventually want to use C# and the Xamarin.iOS and Xamarin.Android libraries to target the native application programming interfaces (APIs) of these platforms. Xamarin.Forms can be a big help in getting programmers started with these platforms or in constructing a prototype or proof-of-concept application.

This book assumes that you know C# and are familiar with the use of the .NET Framework. However, when I discuss some C# and .NET features that might be somewhat exotic or unfamiliar to recent C# programmers, I adopt a somewhat slower pace.
Conventions and features in this book

This book has just a few typographical conventions:

- All programming elements referenced in the text—including classes, methods, properties, variable names, etc.—are shown in a monospaced font, such as the `StackLayout` class.

- Items that appear in the user interface of Visual Studio or Xamarin Studio, or the applications discussed in these chapters, appear in boldface, such as the `Add New Project` dialog.

- Application solutions and projects also appear in boldface, such as `MonkeyTap`.

The various editions of this book

This book is intended as a tutorial to learn Xamarin.Forms programming. It is not a replacement for the online API documentation, which can be found at the Xamarin.Forms Framework link on this page:

https://developer.xamarin.com/api/

The first Preview Edition of this book was published in October 2014 to coincide with the Xamarin Evolve 2014 conference. It contained six chapters but no coverage of XAML.

This second Preview Edition was reconceived to contain shorter and more focused chapters. The sixteen chapters of the second Preview Edition were published in April 2015 to coincide with the Microsoft Build 2015 conference. Over the next six months, eight more chapters were published online, bringing the total to 24.

This edition has 27 chapters and is being published to coincide with the Xamarin Evolve 2016 conference taking place April 24–28, 2016. But the deadline for this book is about a month earlier than Evolve, and several topics did not make it into this edition. These include maps, ControlTemplate, DataTemplateSelector, the Margin property, and CarouselView. Of the classes that derive from GestureRecognizer, only TapGestureRecognizer is covered, and not PanGestureRecognizer or PinchGestureRecognizer. Although RelativeLayout dates from the very first release of Xamarin.Forms, somehow it never made it into this book.

Between the second Preview Edition and this edition, a big change occurred for the Windows platforms: The sample programs no longer support the Silverlight API of Windows Phone 8.0. Instead, all the sample programs support the Universal Windows Platform for targeting Windows 10 and Windows 10 Mobile, and the Windows Runtime for targeting Windows 8.1 and Windows Phone 8.1.

However, there was insufficient time to update this book’s sample programs and screenshots to reflect Android AppCompat and Material Design, which is expected to be supported in a forthcoming Visual Studio and Xamarin Studio project template for Xamarin.Forms.
System requirements

This book assumes that you’ll be using Xamarin.Forms to write applications that simultaneously target all the supported mobile platforms—iOS, Android, the Universal Windows Platform, and perhaps Windows Phone 8.1 as well. However, it’s possible that some readers will be targeting only one or two platforms in their Xamarin.Forms solutions. The platforms you target govern your hardware and software requirements. For targeting iOS devices, you’ll need a Mac installed with Apple Xcode and the Xamarin Platform, which includes Xamarin Studio. For targeting any of the Windows platforms, you’ll need Visual Studio 2015 on a PC, and you’ll need to have installed the Xamarin Platform.

However, you can also use Visual Studio on the PC to target iOS devices through a Wi-Fi-accessible Mac installed with Xcode and the Xamarin Platform. You can target Android devices from Visual Studio on the PC or from Xamarin Studio on the Mac.

Chapter 1, “How does Xamarin.Forms fit in?” has more details on the various configurations you can use and resources for additional information and support. My setup for creating this book consisted of a Microsoft Surface Pro 2 (with external monitor, keyboard, and mouse) installed with Visual Studio 2015 and the Xamarin Platform, connected by Wi-Fi with a MacBook Pro installed with Xcode and the Xamarin Platform.

Most of the screenshots in this book show an iPhone, an Android phone, and a Windows 10 Mobile device in that order. The three devices shown in these screenshots reflect my setup and hardware:

- The iPhone 6 simulator on the MacBook Pro running iOS 8.2
- An LG Nexus 5 running Android 6.0.1
- A Nokia Lumia 925 running Windows 10 Mobile

Additional screenshots use an iPad Air 2 simulator, a Microsoft Surface Pro 3 running Windows 10 in tablet mode, a Windows 10 Mobile phone running a program targeting Windows Phone 8.1, and the Windows 10 desktop running a program targeting Windows 8.1.

Some of the early triple screenshots in this book used devices with somewhat earlier versions of the operating systems, for example Android 5.0 or 5.1. Although I tried to use real devices for all the Android and Windows screenshots, in the interests of expediency some Windows Phone and Windows 10 Mobile screenshots were taken with a Windows 10 Mobile emulator.
Downloads: Code samples

The sample programs shown in the pages of this book were compiled in late March 2016 with Xamarin.Forms version 2.1.0. The source code of these samples is hosted on a repository on GitHub:

http://aka.ms/xamarinbook/codesamples

You can clone the directory structure to a local drive on your machine or download a big ZIP folder. I’ll try to keep the code updated with the latest release of Xamarin.Forms and to fix (and comment) any errors that might have sneaked through.

You can report problems, bugs, or other kinds of feedback about the book or source code by clicking the Issues button on this GitHub page. You can search through existing issues or file a new one. To file a new issue, you’ll need to join GitHub (if you haven’t already).

Use this GitHub page only for issues involving the book. For questions or discussions about Xamarin.Forms itself, use the Xamarin.Forms forum:

http://forums.xamarin.com/categories/xamarin-forms

Updating the code samples

The libraries that make up Xamarin.Forms are distributed via the NuGet package manager. The Xamarin.Forms package consists of a collection of dynamic-link libraries, the most significant of which are:

- Xamarin.Forms.Core.dll
- Xamarin.Forms.Xaml.dll
- Xamarin.Forms.Platform.dll
- Xamarin.Forms.Platform.iOS.dll
- Xamarin.Forms.Platform.WinRT.dll
- Xamarin.Forms.Platform.WinRT.Phone.dll
- Xamarin.Forms.Platform.WinRT.Tablet.dll
- Xamarin.Forms.Platform.UAP.dll

The Xamarin.Forms package also requires five Android support libraries, currently identified with the version number 23.0.1.3. These should be automatically included.
When you create a new Xamarin.Forms solution using Visual Studio or Xamarin Studio, a version of the Xamarin.Forms package becomes part of that solution. However, that might not be the latest Xamarin.Forms version available from NuGet. You’ll probably want to update that package to the most recent version.

Also, the source code for this book that is stored on GitHub does not include the actual NuGet packages. Xamarin Studio will automatically download them when you load the solution, but by default Visual Studio will not.

In Visual Studio, you can handle both these jobs by right-clicking the solution name in the Solution Explorer and selecting Manage NuGet Packages for Solution. The Manage Packages for Solution dialog lets you download and restore the NuGet packages and to update them.

In Xamarin Studio, the process is somewhat more automatic, but you can also use the Update NuGet Packages and Restore NuGet Packages options on the Project menu.

Some of the projects contain references to libraries in the Libraries folder of the sample code. You’ll want to load those library solutions into Visual Studio or Xamarin Studio separately and restore (or update) the NuGet packages. Then load projects referencing these libraries.

Acknowledgments

It’s always seemed peculiar to me that authors of programming books are sometimes better known to programmers than the people who actually created the product that is the subject of the book! The real brains behind Xamarin.Forms are Jason Smith, Eric Maupin, Stephane Delcroix, Seth Rosetter, Rui Marinho, Chris King, E.Z. Hart, Samantha Houts, Paul DiPietro, and interim product manager Bryan Hunter. Congratulations, guys! We’ve been enjoying the fruits of your labor!

Over the months that these various editions of the book were in progress, I have benefited from valuable feedback, corrections, and edits from several people. This book wouldn’t exist without the collaboration of Bryan Costanich at Xamarin and Devon Musgrave at Microsoft Press. Both Bryan and Craig Dunn at Xamarin read some of my drafts of early chapters and managed to persuade me to take a somewhat different approach to the material. Later on, Craig kept me on track and reviewed the chapters while John Meade did the copyediting. For the first Preview Edition, Stephane Delcroix at Xamarin and Andy Wigley with Microsoft offered essential technical reads and persistently prodded me to make the book better. Rui Marinho was often willing to explore technical questions that I had. Reader Albert Mata found a number of typos. Microsoft’s copyeditor for the second Preview Edition and this edition was John Pierce.

Almost nothing I do these days would be possible without the daily companionship and support of my wife, Deirdre Sinnott.

Charles Petzold
March 21, 2016
Free ebooks from Microsoft Press

From technical overviews to in-depth information, the free ebooks from Microsoft Press cover a wide range of topics. These ebooks are available in PDF, EPUB, and Mobi for Kindle formats, ready for you to download at http://aka.ms/mspressfree.

We want to hear from you

At Microsoft Press, your satisfaction is our top priority and your feedback our most valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress. Your feedback goes directly to the editors at Microsoft Press. (No personal information will be requested.) Thanks in advance for your input!
Chapter 1
How does Xamarin.Forms fit in?

There is much joy in programming. There is joy in analyzing a problem, breaking it down into pieces, formulating a solution, mapping out a strategy, approaching it from different directions, and crafting the code. There is very much joy in seeing the program run for the first time, and then more joy in eagerly diving back into the code to make it better and faster.

There is also often joy in hunting down bugs, in ensuring that the program runs smoothly and predictably. Few occasions are quite as joyful as finally identifying a particularly recalcitrant bug and definitively stamping it out.

There is even joy in realizing that the original approach you took is not quite the best. Many developers discover that they’ve learned a lot while writing a program, including that there’s a better way to structure the code. Sometimes, a partial or even a total rewrite can result in a much better application, or simply one that is structurally more coherent and easier to maintain. The process is like standing on one’s own shoulders, and there is much joy in attaining that perspective and knowledge.

However, not all aspects of programming are quite so joyful. One of the nastier programming jobs is taking a working program and rewriting it in an entirely different programming language or porting it to another operating system with an entirely different application programming interface (API).

A job like that can be a real grind. Yet, such a rewrite may very well be necessary: an application that’s been so popular on the iPhone might be even more popular on Android devices, and there’s only one way to find out.

But here’s the problem: As you’re going through the original source code and moving it to the new platform, do you maintain the same program structure so that the two versions exist in parallel? Or do you try to make improvements and enhancements?

The temptation, of course, is to entirely rethink the application and make the new version better. But the further the two versions drift apart, the harder they will be to maintain in the future.

For this reason, a sense of dread pervades the forking of one application into two. With each line of code that you write, you realize that all the future maintenance work, all the future revisions and enhancements, have become two jobs rather than one.

This is not a new problem. For over half a century, developers have craved the ability to write a single program that runs on multiple machines. This is one of the reasons that high-level languages were invented in the first place, and this is why the concept of “cross-platform development” continues to exert such a powerful allure for programmers.
Cross-platform mobile development

The personal computer industry has experienced a massive shift in recent years. Desktop computers still exist, of course, and they remain vital for tasks that require keyboards and large screens: programming, writing, spread-sheeting, data tracking. But much of personal computing now occurs on smaller devices, particularly for quick information, media consumption, and social networking. Tablets and smartphones have a fundamentally different user-interaction paradigm based primarily on touch, with a keyboard that pops up only when necessary.

The mobile landscape

Although the mobile market has the potential for rapid change, currently two major phone and tablet platforms dominate:

- The Apple family of iPhones and iPads, all of which run the iOS operating system.
- The Android operating system, developed by Google based on the Linux kernel, which runs on a variety of phones and tablets.

How the world is divided between these two giants depends on how they are measured: there are more Android devices currently in use, but iPhone and iPad users are more devoted and spend more time with their devices.

There is also a third mobile development platform, which is not as popular as iOS and Android but involves a company with a strong history in the personal computer industry:

- Microsoft’s Windows Phone and Windows 10 Mobile.

In recent years, these platforms have become a more compelling alternative as Microsoft has been merging the APIs of its mobile, tablet, and desktop platforms. Both Windows 8.1 and Windows Phone 8.1 are based on a single API called the Windows Runtime (or WinRT), which is based on Microsoft .NET. This single API means that applications targeted for desktop machines, laptops, tablets, and phones can share very much of their code.

Even more compelling is the Universal Windows Platform (UWP), a version of the Windows Runtime that forms the basis for Windows 10 and Windows 10 Mobile. A single UWP application can target every form factor from the desktop to the phone.

For software developers, the optimum strategy is to target more than just one of these platforms. But that’s not easy. There are four big obstacles:

Problem 1: Different user-interface paradigms

All three platforms incorporate similar ways of presenting the graphical user interface (GUI) and interaction with the device through multitouch, but there are many differences in detail. Each platform has
different ways to navigate around applications and pages, different conventions for the presentation of data, different ways to invoke and display menus, and even different approaches to touch.

Users become accustomed to interacting with applications on a particular platform and expect to leverage that knowledge with future applications as well. Each platform acquires its own associated culture, and these cultural conventions then influence developers.

**Problem 2: Different development environments**

Programmers today are accustomed to working in a sophisticated integrated development environment (IDE). Such IDEs exist for all three platforms, but of course they are different:

- For iOS development, Xcode on the Mac.
- For Android development, Android Studio on a variety of platforms.
- For Windows development, Visual Studio on the PC.

**Problem 3: Different programming interfaces**

All three of these platforms are based on different operating systems with different APIs. In many cases, the three platforms all implement similar types of user-interface objects but with different names.

For example, all three platforms have something that lets the user toggle a Boolean value:

- On the iPhone or iPad, it’s a “view” called UISwitch.
- On Android devices, it’s a “widget” called Switch.
- In the Windows Runtime API, it’s a “control” called ToggleSwitch.

Of course, the differences go far beyond the names into the programming interfaces themselves.

**Problem 4: Different programming languages**

Developers have some flexibility in choosing a programming language for each of these three platforms, but, in general, each platform is very closely associated with a particular programming language:

- Objective-C for the iPhone and iPad
- Java for Android devices
- C# for Windows

Objective-C, Java, and C# are cousins of sorts because they are all object-oriented descendants of C, but they have become rather distant cousins.
For these reasons, a company that wants to target multiple platforms might very well employ three different programmer teams, each team skilled and specialized in a particular language and API.

This language problem is particularly nasty, but it’s the problem that is the most tempting to solve: If you could use the same programming language for these three platforms, you could at least share some code between the platforms. This shared code likely wouldn’t be involved with the user interface because each platform has different APIs, but there might well be application code that doesn’t touch the user interface at all.

A single language for these three platforms would certainly be convenient. But what language would that be?

The C# and .NET solution

A roomful of programmers would come up with a variety of answers to the question just posed, but a good argument can be made in favor of C#. Unveiled by Microsoft in the year 2000, C# is a fairly new programming language, at least when compared with Objective-C and Java. At first, C# seemed to be a rather straightforward, strongly typed, imperative object-oriented language, certainly influenced by C++ (and Java as well), but with a much cleaner syntax than C++ and none of the historical baggage. In addition, the first version of C# had language-level support for properties and events, which turn out to be member types that are particularly suited for programming graphical user interfaces.

But C# has continued to grow and get better over the years. The support of generics, lambda functions, LINQ, and asynchronous operations has successfully transformed C# so that it is now properly classified as a multiparadigm programming language. C# code can be traditionally imperative, or the code can be flavored with declarative or functional programming paradigms.

Since its inception, C# has been closely associated with the Microsoft .NET Framework. At the lowest level, .NET provides an infrastructure for the C# basic data types (int, double, string, and so forth). But the extensive .NET Framework class library provides support for many common chores encountered in many different types of programming. These include:

- Math
- Debugging
- Reflection
- Collections
- Globalization
- File I/O
- Networking
Chapter 1  How does Xamarin.Forms fit in?

- Security
- Threading
- Web services
- Data handling
- XML and JSON reading and writing

Here's another big reason for C# and .NET to be regarded as a compelling cross-platform solution:

*It's not just hypothetical. It's a reality.*

Soon after Microsoft's announcement of .NET way back in June 2000, the company Ximian (founded by Miguel de Icaza and Nat Friedman) initiated an open-source project called Mono to create an alternative implementation of the C# compiler and the .NET Framework that could run on Linux.

A decade later, in 2011, the founders of Ximian (which had been acquired by Novell) founded Xamarin, which still contributes to the open-source version of Mono but which has also adapted Mono to form the basis of cross-platform mobile solutions.

The year 2014 saw some developments in C# and .NET that bode well for its future. An open-source version of the C# compiler, called the .NET Compiler Platform (formerly known by its code name “Roslyn”) has been published. And the .NET Foundation was announced to serve as a steward for open-source .NET technologies, in which Xamarin plays a major part.

In March 2016, Microsoft acquired Xamarin with the goal of bringing cross-platform mobile development to the wider Microsoft developer community. Xamarin.Forms is now freely available to all users of Visual Studio.

**A single language for all platforms**

For the first three years of its existence, Xamarin focused mainly on compiler technologies and three basic sets of .NET libraries:

- Xamarin.Mac, which has evolved from the MonoMac project.
- Xamarin.iOS, which evolved from MonoTouch.
- Xamarin.Android, which evolved from Mono for Android or (more informally) MonoDroid.

Collectively, these libraries are known as the Xamarin platform. The libraries consist of .NET versions of the native Mac, IOS, and Android APIs. Programmers using these libraries can write applications in C# to target the native APIs of these three platforms, but also (as a bonus) with access to the .NET Framework class library.
Developers can use Visual Studio to build Xamarin applications, targeting iOS and Android as well as all the various Windows platforms. However, iPhone and iPad development also requires a Mac connected to the PC through a local network. This Mac must have Xcode installed as well as Xamarin Studio, an OS X–based integrated development environment that lets you develop iPhone, iPad, Mac OS X, and Android applications on the Mac. Xamarin Studio does not allow you to target Windows platforms.

**Sharing code**

The advantage of targeting multiple platforms with a single programming language comes from the ability to share code among the applications.

Before code can be shared, an application must be structured for that purpose. Particularly since the widespread use of graphical user interfaces, programmers have understood the importance of separating application code into functional layers. Perhaps the most useful division is between user-interface code and the underlying data models and algorithms. The popular MVC (Model-View-Controller) application architecture formalizes this code separation into a Model (the underlying data), the View (the visual representation of the data), and the Controller (which handles input from the user).

MVC originated in the 1980s. More recently, the MVVM (Model-View-ViewModel) architecture has effectively modernized MVC based on modern GUIs. MVVM separates code into the Model (the underlying data), the View (the user interface, including visuals and input), and the ViewModel (which manages data passing between the Model and the View).

When a programmer develops an application that targets multiple mobile platforms, the MVVM architecture helps guide the developer into separating code into the platform-specific View—the code that requires interacting with the platform APIs—and the platform-independent Model and ViewModel.

Often this platform-independent code needs to access files or the network or use collections or threading. Normally these jobs would be considered part of an operating system API, but they are also jobs that can make use of the .NET Framework class library, and if .NET is available on each platform, then this code is effectively platform independent.

The part of the application that is platform independent can then be isolated and—in the context of Visual Studio or Xamarin Studio—put into a separate project. This can be either a Shared Asset Project (SAP)—which simply consists of code and other asset files accessible from other projects—or a Portable Class Library (PCL), which encloses all the common code in a dynamic-link library (DLL) that can then be referenced from other projects.

Whichever method you use, this common code has access to the .NET Framework class library, so it can perform file I/O, handle globalization, access web services, decompose XML, and so forth.
This means that you can create a single Visual Studio solution that contains four C# projects to target the three major mobile platforms (all with access to a common PCL or SAP), or you can use Xamarin Studio to target iPhone and Android devices.

The following diagram illustrates the interrelationships between the Visual Studio or Xamarin Studio projects, the Xamarin libraries, and the platform APIs. The third column refers to any .NET-based Windows Platform regardless of the device:

![Diagram illustrating interrelationships between Visual Studio or Xamarin Studio projects, Xamarin libraries, and platform APIs.](image)

The boxes in the second row are the actual platform-specific applications. These apps make calls into the common project and also (with the iPhone and Android) the Xamarin libraries that implement the native platform APIs.

But the diagram is not quite complete: it doesn’t show the SAP or PCL making calls to the .NET Framework class library. Exactly what version of .NET this is depends on the common code: A PCL has access to its own version of .NET, while an SAP uses the version of .NET incorporated into each particular platform.

In this diagram, the Xamarin.iOS and Xamarin.Android libraries seem to be substantial, and while they are certainly important, they’re mostly just language bindings and do not significantly add any overhead to API calls.

When the iOS app is built, the Xamarin C# compiler generates C# Intermediate Language (IL) as usual, but it then makes use of the Apple compiler on the Mac to generate native iOS machine code just like the Objective-C compiler. The calls from the app to the iOS APIs are the same as though the application were written in Objective-C.
Chapter 1  How does Xamarin.Forms fit in?

For the Android app, the Xamarin C# compiler generates IL, which runs on a version of Mono on the device alongside the Java engine, but the API calls from the app are pretty much the same as though the app were written in Java.

For mobile applications that have very platform-specific needs, but also a potentially shareable chunk of platform-independent code, Xamarin.iOS and Xamarin.Android provide excellent solutions. You have access to the entire platform API, with all the power (and responsibility) that implies.

But for applications that might not need quite so much platform specificity, there is an alternative that will simplify your life even more.

Introducing Xamarin.Forms

On May 28, 2014, Xamarin introduced Xamarin.Forms, which allows you to write user-interface code that can be compiled for the iOS, Android, and Windows devices.

The Xamarin.Forms option

Xamarin.Forms supports five distinct application platforms:

- iOS for programs that run on the iPhone, iPad, and iPod Touch.
- Android for programs that run on Android phones and tablets.
- The Universal Windows Platform (UWP) for applications that run under Windows 10 or Windows 10 Mobile.
- The Windows Runtime API of Windows Phone 8.1.

In this book, “Windows” or “Windows Phone” will generally be used as a generic term to describe all three of the Microsoft platforms.

In the general case, a Xamarin.Forms application in Visual Studio consists of five separate projects for each of these five platforms, with a sixth project containing common code. But the five platform projects in a Xamarin.Forms application are typically quite small—often consisting of just stubs with a little boilerplate startup code. The PCL or SAP contains the bulk of the application, including the user-interface code. The following diagram shows just the iOS, Android, and Universal Windows Platform. The other two Windows platforms are similar to UWP:
The **Xamarin.Forms.Core** and **Xamarin.Forms.Xaml** libraries implement the Xamarin.Forms API. Depending on the platform, **Xamarin.Forms.Core** then makes use of one of the **Xamarin.Forms.Platform** libraries. These libraries are mostly a collection of classes called *renderers* that transform the Xamarin.Forms user-interface objects into the platform-specific user interface.

The remainder of the diagram is the same as the one shown earlier.

For example, suppose you need the user-interface object discussed earlier that allows the user to toggle a Boolean value. When programming for Xamarin.Forms, this is called a *Switch*, and a class named `Switch` is implemented in the **Xamarin.Forms.Core** library. In the individual renderers for the three platforms, this `Switch` is mapped to a `UISwitch` on the iPhone, a `Switch` on Android, and a `ToggleSwitch` on Windows Phone.

**Xamarin.Forms.Core** also contains a class named `Slider` for displaying a horizontal bar that the user manipulates to choose a numeric value. In the renderers in the platform-specific libraries, this is mapped to a `UISlider` on the iPhone, a `SeekBar` on Android, and a `Slider` on Windows Phone.
This means that when you write a Xamarin.Forms program that has a Switch or a Slider, what’s actually displayed is the corresponding object implemented in each platform.

Here’s a little Xamarin.Forms program containing a Label reading “Hello, Xamarin.Forms!”, a Button saying “Click Me!”, a Switch, and a Slider. The program is running on (from left to right) the iPhone, an Android phone, and a Windows 10 Mobile device:

The iPhone screenshot is of an iPhone 6 simulator running iOS 9.2. The Android phone is an LG Nexus 5 running Android version 6. The Windows 10 Mobile device is a Nokia Lumia 935 running a Windows 10 Technical Preview.

You’ll encounter triple screenshots like this one throughout this book. They’re always in the same order—iPhone, Android, and Windows 10 Mobile—and they’re always running the same program.

As you can see, the Button, Switch, and Slider all have different appearances on the three phones because they are all rendered with the object specific to each platform.

What’s even more interesting is the inclusion in this program of six ToolbarItem objects, three identified as primary items with icons, and three as secondary items without icons. On the iPhone these are rendered with UIBarButtonItem objects as the three icons and three buttons at the top of the page. On the Android, the first three are rendered as items on an ActionBar, also at the top of the page. On Windows 10 Mobile, they’re realized as items on the CommandBar at the page’s bottom.

The Android ActionBar has a vertical ellipsis and the Universal Windows Platform CommandBar has a horizontal ellipsis. Tapping this ellipsis causes the secondary items to be displayed in a manner appropriate to these two platforms:
Xamarin.Forms was originally conceived as a platform-independent API for mobile devices. However, Xamarin.Forms is not limited to phones. Here's the same program running on an iPad Air 2 simulator:

Most of the programs in this book are fairly simple, and hence designed to look their best on a phone screen in portrait mode. But they will also run in landscape mode and on tablets.

Here's the UWP project on a Microsoft Surface Pro 3 running Windows 10:
Notice the toolbar at the top of the screen. The ellipsis has already been pressed to reveal the three secondary items.

The other two platforms supported by Xamarin.Forms are Windows 8.1 and Windows Phone 8.1. Here’s the Windows 8.1 program running in a window on the Windows 10 desktop, and the Windows 8.1 program running on the Windows 10 Mobile device:
Chapter 1  How does Xamarin.Forms fit in?

The Windows 8.1 screen has been left-clicked with the mouse to reveal the toolbar items at the bottom. On this screen, the secondary items are at the left, but the program neglectfully forgot to assign them icons. On the Windows Phone 8.1 screen, the ellipsis at the bottom has been pressed.

The various implementations of the toolbar reveals that, in one sense, Xamarin.Forms is an API that virtualizes not only the user-interface elements on each platform, but also the user-interface paradigms.

XAML support

Xamarin.Forms also supports XAML (pronounced “zammel” to rhyme with “camel”), the XML-based Extensible Application Markup Language developed at Microsoft as a general-purpose markup language for instantiating and initializing objects. XAML isn’t limited to defining initial layouts of user interfaces, but historically that’s how it’s been used the most, and that’s what it’s used for in Xamarin.Forms.

Here’s the XAML file for the program whose screenshots you’ve just seen:

```xml
    <StackLayout Padding="10,0">
        <Label Text="Hello, Xamarin.Forms!" FontSize="Large"
            VerticalOptions="CenterAndExpand"
            HorizontalOptions="Center" />

        <Button Text = "Click Me!"
            VerticalOptions="CenterAndExpand"
            HorizontalOptions="Center" />

        <Switch VerticalOptions="CenterAndExpand"
            HorizontalOptions="Center" />

        <Slider VerticalOptions="CenterAndExpand" />
    </StackLayout>

    <ContentPage.ToolbarItems>
        <ToolbarItem Text="edit" Order="Primary">
            <ToolbarItem.Icon>
                <OnPlatform x:TypeArguments="FileImageSource"
                    iOS="edit.png"
                    Android="ic_action_edit.png"
                    WinPhone="Images/edit.png" />
            </ToolbarItem.Icon>
        </ToolbarItem>
        <ToolbarItem Text="search" Order="Primary">
            <ToolbarItem.Icon>
            </ToolbarItem.Icon>
        </ToolbarItem>
    </ContentPage.ToolbarItems>
</ContentPage>
```
Unless you have experience with XAML, some syntax details might be a little obscure. (Don’t worry; you’ll learn all about them later on in this book.) But even so, you can see the Label, Button, Switch, and Slider tags. In a real program, the Button, Switch, and Slider would probably have event handlers attached that would be implemented in a C# code file. Here they do not. The VerticalOptions and HorizontalOptions attributes assist in layout; they are discussed in the next chapter.

Platform specificity

In the section of that XAML file involving the ToolbarItem, you can also see a tag named OnPlatform. This is one of several techniques in Xamarin.Forms that allow introducing some platform specificity in otherwise platform-independent code or markup. It’s used here because each of the separate platforms has somewhat different image format and size requirements associated with these icons.

A similar facility exists in code with the Device class. It’s possible to determine what platform the code is running on and to choose values or objects based on the platform. For example, you can specify different font sizes for each platform or run different blocks of code based on the platform. You might want to let the user manipulate a Slider to select a value in one platform but pick a number from a set of explicit values in another platform.

In some applications, deeper platform specificities might be desired. For example, suppose your application requires the GPS coordinates of the user’s phone. This is not something that Xamarin.Forms provides, so you’d need to write your own code specific to each platform to obtain this information.

The DependencyService class provides a way to do this in a structured manner. You define an interface with the methods you need (for example, IGetCurrentLocation) and then implement that interface with a class in each of the platform projects. You can then call the methods in that interface
Chapter 1  How does Xamarin.Forms fit in?

from the Xamarin.Forms project almost as easily as if it were part of the API.

Each of the standard Xamarin.Forms visual objects—such as Label, Button, Switch, and Slider—are supported by a renderer class in the various Xamarin.Forms.Platform libraries. Each renderer class implements the platform-specific object that maps to the Xamarin.Forms object.

You can create your own custom visual objects with your own custom renderers. The custom visual object goes in the common code project, and the custom renderers go in the individual platform projects. To make it a bit easier, generally you’ll want to derive from an existing class. Within the individual Xamarin.Forms platform libraries, all the corresponding renderers are public classes, and you can derive from them as well.

Xamarin.Forms allows you to be as platform independent or as platform specific as you need to be. Xamarin.Forms doesn’t replace Xamarin.iOS and Xamarin.Android; rather, it integrates with them.

A cross-platform panacea?

For the most part, Xamarin.Forms defines its abstractions with a focus on areas of the mobile user interface that are common to the iOS, Android, and Windows Runtime APIs. These Xamarin.Forms visual objects are mapped to platform-specific objects, but Xamarin.Forms has tended to avoid implementing anything that is unique to a particular platform.

For this reason, despite the enormous help that Xamarin.Forms can offer in creating platform-independent applications, it is not a complete replacement for native API programming. If your application relies heavily on native API features such as particular types of controls or widgets, then you might want to stick with Xamarin.iOS, Xamarin.Android, and the native Windows Phone API.

You’ll probably also want to stick with the native APIs for applications that require vector graphics or complex touch interaction. The current version of Xamarin.Forms is not quite ready for these scenarios.

On the other hand, Xamarin.Forms is great for prototyping or making a quick proof-of-concept application. And after you’ve done that, you might just find that you can continue using Xamarin.Forms features to build the entire application. Xamarin.Forms is ideal for line-of-business applications.

Even if you begin building an application with Xamarin.Forms and then implement major parts of it with platform APIs, you’re doing so within a framework that allows you to share code and that offers structured ways to make platform-specific visuals.

Your development environment

How you set up your hardware and software depends on what mobile platforms you’re targeting and what computing environments are most comfortable for you.
The requirements for Xamarin.Forms are no different from the requirements for using Xamarin.iOS or Xamarin.Android or for programming for Windows Runtime platforms.

This means that nothing in this section (and the remainder of this chapter) is specific to Xamarin.Forms. There exists much documentation on the Xamarin website on setting up machines and software for Xamarin.iOS and Xamarin.Android programming, and on the Microsoft website about Windows Phone.

**Machines and IDEs**

If you want to target the iPhone, you’re going to need a Mac. Apple requires that a Mac be used for building iPhone and other iOS applications. You’ll need to install Xcode on this machine and, of course, the Xamarin platform that includes the necessary libraries and Xamarin Studio. You can then use Xamarin Studio and Xamarin.Forms on the Mac for your iPhone development.

Once you have a Mac with Xcode and the Xamarin platform installed, you can also install the Xamarin platform on a PC and program for the iPhone by using Visual Studio. The PC and Mac must be connected via a network (such as Wi-Fi). Visual Studio communicates with the Mac through a Secure Shell (SSH) interface, and uses the Mac to build the application and run the program on a device or simulator.

You can also do Android programming in Xamarin Studio on the Mac or in Visual Studio on the PC.

If you want to target the Windows platforms, you’ll need Visual Studio 2015. You can target all the platforms in a single IDE by running Visual Studio 2015 on a PC connected to the Mac via a network. (That’s how the sample programs in this book were created.) Another option is to run Visual Studio in a virtual machine on the Mac.

**Devices and emulators**

You can test your programs on real phones connected to the machines via a USB cable, or you can test your programs with onscreen emulators.

There are advantages and disadvantages to each approach. A real phone is essential for testing complex touch interaction or when getting a feel for startup or response time. However, emulators allow you to see how your application adapts to a variety of sizes and form factors.

The iPhone and iPad emulators run on the Mac. However, because Mac desktop machines don’t have touchscreens, you’ll need to use the mouse or trackpad to simulate touch. The touch gestures on the Mac touchpad do not translate to the emulator. You can also connect a real iPhone to the Mac, but you’ll need to provision it as a developer device.

Historically, Android emulators supplied by Google have tended to be slow and cranky, although they are often extremely versatile in emulating a vast array of actual Android devices. Fortunately, Visual Studio now has its own Android emulator that works rather better. It’s also very easy to connect
a real Android phone to either a Mac or PC for testing. All you really need do is enable USB Debugging on the device.

The Windows Phone emulators are capable of several different screen resolutions and also tend to run fairly smoothly, albeit consuming lots of memory. If you run the Windows Phone emulator on a touchscreen, you can use touch on the emulator screen. Connecting a real Windows Phone to the PC is fairly easy but requires enabling the phone in the Settings section for developing. If you want to unlock more than one phone, you’ll need a developer account.

**Installation**

Before writing applications for Xamarin.Forms, you’ll need to install the Xamarin platform on your Mac, PC, or both (if you’re using that setup). See the articles on the Xamarin website at:

[https://developer.xamarin.com/guides/cross-platform/getting_started/installation/](https://developer.xamarin.com/guides/cross-platform/getting_started/installation/)

You’re probably eager to create your first Xamarin.Forms application, but before you do, you’ll want to try creating normal Xamarin projects for the iPhone and Android and normal Windows, Windows Phone, and Windows 10 Mobile projects.

This is important: if you’re experiencing a problem using Xamarin.iOS, Xamarin.Android, or Windows, that’s not a problem with Xamarin.Forms, and you’ll need to solve that problem before using Xamarin.Forms.

**Creating an iOS app**

If you’re interested in using Xamarin.Forms to target the iPhone, first become familiar with the appropriate Getting Started documents on the Xamarin website:


This will give you guidance on using the Xamarin.iOS library to develop an iPhone application in C#. All you really need to do is get to the point where you can build and deploy a simple iPhone application on either a real iPhone or the iPhone simulator.

If you’re using Visual Studio, and if everything is installed correctly, you should be able to select File > New > Project from the menu, and in the New Project dialog, from the left, select Visual C# and iOS and then Universal (which refers to targeting both iPhone and iPad), and from the template list in the center, select Blank App (iOS).

If you’re using Xamarin Studio, you should be able to select File > New > Solution from the menu, and in the New Project dialog, from the left, select iOS and then App, and from the template list in the center, select Single View App.
In either case, select a location and name for the solution. Build and deploy the skeleton application created in the project. If you’re having a problem with this, it’s not a Xamarin.Forms issue. You might want to check the Xamarin.iOS forums to see if anybody else has a similar problem:

http://forums.xamarin.com/categories/ios/

Creating an Android app

If you’re interested in using Xamarin.Forms to target Android devices, first become familiar with the Getting Started documents on the Xamarin website:

https://developer.xamarin.com/guides/android/getting_started/

If you’re using Visual Studio, and if everything is installed correctly, you should be able to select File > New > Project from the menu, and in the New Project dialog, from the left, select Visual C# and then Android, and from the template list in the center, select Blank App (Android).

If you’re using Xamarin Studio, you should be able to select File > New > Solution from the menu, and in the New Project dialog, from the left, select Android and App, and in the template list in the center, select Android App.

Give it a location and a name; build and deploy. If you can’t get this process to work, it’s not a Xamarin.Forms issue, and you might want to check the Xamarin.Android forums for a similar problem:

http://forums.xamarin.com/categories/android/

Creating a Windows app

If you’re interested in using Xamarin.Forms to target Windows, Windows Phone, or Windows 10 Mobile, you’ll need to become familiar with at least the rudiments of using Visual Studio to develop Windows applications:

http://dev.windows.com/

In Visual Studio 2015, if everything is installed correctly, you should be able select File > New > Project from the menu, and in the New Project dialog, at the left, select Visual C# and Windows. You’ll see a hierarchy under the Windows heading something like this:
The first **Universal** heading under **Windows** is for creating a Universal Windows Platform application that can target either Windows 10 or Windows 10 Mobile. Select that, and from the center area select **Blank App (Universal Windows)** to create a UWP app.

The other two project types supported by Xamarin.Forms are under the Windows 8 header. The **Universal** item actually creates two projects—a Windows desktop application and a Windows Phone application with some shared code. For creating just a Windows application, choose **Windows** and then from the center section **Blank App (Windows 8.1)**. For a Windows Phone application, choose **Windows Phone** and **Blank App**. This creates a project that targets Windows Phone 8.1.

These are the three project types supported by Xamarin.Forms.

You should be able to build and deploy the skeleton application to the desktop or to a real phone or an emulator. If not, search the Microsoft website or online forums such as Stack Overflow.

**All ready?**

If you can build Xamarin.iOS, Xamarin.Android, and Windows applications (or some subset of those), then you’re ready to create your first Xamarin.Forms application. It’s time to say “Hello, Xamarin.Forms” to a new era in cross-platform mobile development.